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1. Overview:

GooyLCD IDE is a low cost, yet very powerful integrated development environment for monochrome
displays. With GooyLCD IDE you will be able to create a professional graphical user interface on your PC
without the need for constant downloading or trial and error sessions. It supports GLC-Mxx series and
comes loaded with advanced utilities and functions like font and bitmap editor, GUI objects, programming
utility, proportional fonts, real time simulator …etc. Be up and running with your GUI LCD application in
just few hours. Save weeks of hard graphic programming.

The key for robust, user-friendly and elegant user interface is a prototype, test and repeat until it is right.
With GooyLCD IDE, you will be able to design, redesign, test and simulate with only few clicks, which
allows for rapid and effective user interface creation with minimum prototype cycle time. You can start
designing your GUI application before your hardware is ready and because GooyLCD is easy to use, the
marketing and sales personal can also involve in this phase of the design.

2. Features:

·  Supports  GLC-Mxx series
·  Real time interface between the software and the module
·  Visual screen builder
·  Font editor
·  Bitmap editor
·  Image loader
·  Real time object simulator
·  20 predefined objects menu
·  Object browser
·  Project report
·  Programming utility for production purposes
·  Touch screen, Contrast, Terminal, Brightness, Alarm and Beep utilities
·  Objects, text and graphics can be placed at any pixel within the view area of the display
·  6 proportional fonts ( 8X8, 8X16, 16X24)
·  Open and save projects
·  Open and save bitmaps
·  Open and save fonts
·  Configurable display (view area) dimension
·  Configurable display resolution
·  Configurable display back color
·  Configurable display fore color
·  Objects auto size function
·  Start up settings window
·  Module configuration window
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3. System requirements:

·  Intel-based Pentium or compatible personal computer
·  Windows 98, XP or Vista
·  CD-ROM drive
·  128 MB RAM or higher
·  USB or RS232 Port

4. Installation:

·  Insert the CD into your CD-ROM drive
·  From the Start menu, choose Run and type D:\SETUP. Click OK
·  Follow the on-screen instructions to complete the installation

5. Interface:

RS232 serial bus is used to communicate with the module. If your PC does not have a serial port, and then
you can use a USB to serial converter, which will install a virtual com port in your PC. Not all USB to
serial converters in the market today have the same performance, some of them may be not suitable for
high speed interface like the one we use. From our experience, we recommend to use Prolific USB to Serial
converter.

6. Display:

GooyLCD treats the target display as graphical canvas, i.e. a drawing surface in which objects can be
placed. All placements are free, so there is no predefined positions or grid, which limits the artistic
freedom.
The display is 1:1 compatible to the target display (LCD) with the origin (0,0) at upper left corner. X- axis
is going from left to right and Y-axis is going downwards. The coordinates are counted in display pixels, so
the display set the limits for the coordinate system.
The display resolution (horizontal and vertical resolution) and the dimensions (width and height) are user
defined and must match the target display resolution and view area dimensions. The maximum display
resolution is 320X240 (QVGA) and the maximum view area dimensions are 125mm (W) X 100mm(H).
The display back and fore color are also user defined and they usually match the target display backlight
color and drawing color.

Edit Display Resolution.
The display resolution must
match the target display
resolution.
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7. Module Select:

GooyLCD is currently support the following modules:
·  GLC-M1x
·  GLC-M2x
·  GLC-M3x

8. Comm port, Baud Rate and Device ID:

The selected baud rate and Device ID (communication address) must match the module baud rate and
device ID for the communication to function properly. The selected com port must exist in your PC and not
be in use by another application.
The default values for the baud rate and device ID for all modules are:
Baud Rate = 19.2Kb/sec
Device ID = 0x10 = 16

Edit Display dimensions (width
and height) in mm.
The display dimensions must
match the target display view
area dimensions.
Enable or disable the dotted 8-
pixels grid.

Edit the display back and
fore (drawing) color.
The highlight color is fixed
to Yellow so, do not use
yellow for back or fore
color

If you use a USB to serial converter, the
installed com port can be from 1 to 255.
In this case select  “Other” and enter the
com port number.
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9. Module Configuration Utility:

This utility is used to configure the module for particular display, set the communication baud rate and
device ID and, select the power up options.
Again, the selected baud rate and device ID must match the one selected through the Comm Port window.
Each module has its own configuration parameters, so some configuration options will be enabled or
disabled depend on the selected module. For more information about the module configuration, see the
module user manual.

10. Contrast Utility:

11. Backlight Utility:

To configure a module:
·  Select and enter your configuration options
·  Click on “Apply”
·  To save the configuration bytes to a file, click on

“Save to Hex file”, enter a file name and then click
on Save.

·  To send these configurations to the module, click
on “Send To Module”

The configuration data will be saved in the module
internal EEPROM and they will be restored after
power on or reset.
The display resolution is already configured (selected)
through the Display Resolution Window .
The splash screen is an image with ID = 0. For
example this image can be your company logo.
The factory configuration is only for Haidar
Technology use.

This utility is used to adjust the target display contrast.
A value from 0 to 255 can be used as contrast level.
This range is not practical for most application.
Manually adjust the contrast level and determine the
practical range for your application. For example from
235 to 245

This utility is used to turn the backlight ON or OFF and
adjust the brightness level. The brightness level
adjustment is only for displays with LED backlight. A
value from 0 to 255 can be used as brightness level. This
range is not practical for most applications. Manually
adjust the brightness level and determine the practical
range for your application
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12. Alarm Utility:

13. Buzzer Utility:

14. Touch Screen Utility:

This utility is used to set the visual and audible alarm.

This utility is used to examine the beep function.

This utility is used to examine the
performance, configure and, calibrate the
touch screen.
When the screen is touched, the touch status
light will turn green.
You can also measure the relative touch
pressure (RT) and see the difference
between a finger and stylus touch.
For more information about the touch
screen, see module user manual.
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15. Terminal Utility:

This utility is used to examine the Terminal
commands. See the module user manual for more
information about the terminal commands.
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16. Button Functions:

Button Function
Open file

Save file

Clear target display (LCD)

Refresh Display

Show Touch Zones

Move Fast (8 pixels)

Move Smooth (1 pixel)

Move Left

Move Right

Move Up

Move Down

Send To Module

Save To EEPROM

Show From EEPROM

Switch between Negative and Positive
Picture
White Pen

Black Pen

Delete

Object Property

Simulate

Send Screen To module (the screen will
not be saved in the module EEPROM)
Zoom Out

Zoom In
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17. Font Editor

A single font is edited in this window.

The font editor window is divided into four panels:
·  Single Character: shows the currently selected character
·  Characters List: shows all characters in the currently selected font
·  Commands: commands for editing, selecting, loading, and saving to module. It also provides

information about the selected font and character like width, height …etc
·  Editing Tools: contain tools for character editing.

17.1. Font Setup:

6 fonts are provided for proportional writing. In proportional writing, the characters are written according
to their width with one blank pixel between them. All characters are written with proportional spacing
except  “0 – 9”, “/”, “\” “-“, “+”, “*” and “ “ (sp ace) are written with mono spacing (fixed width). The
character width and height are automatically calculated for the selected character.

Single Character

Characters
List

Commands

Editing
Tools
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·  Select Font: This will select the character cell size and font code to be used by the module for saving
and writing. The following table shows the font list:

Font Cell Size # of CHRs Font Code
Font 1 8 X 8 128 50
Font 2 8 X 8 128 51
Font 3 8 X 16 128 52
Font 4 8 X 16 128 53
Font 5 16 X 24 128 54
Font 6 16 X 24 128 55

All fonts contain up to 128 characters (ASCII codes from 0x20 to 0x9F). ASCII codes from 0x00 to 0x1F
must not be used. Once the font is selected, the single character matrix will be updated to the new cell size.
The character size must not exceed the cell size.

·  Top Line: A value from 0 to (cell height –1) can be used. Capital letters are usually placed between
the base line and the top line. Letters with accents can utilize the area above the top line.
The top line value determines the “InternalLeeding” space for the selected character. When a system
font is loaded, all characters will be shifted vertically up or down according to the top line value.

·  Mid Line: A value from 0 to (cell height – 1) can be used. Lower case letters are usually placed
between the base line and the mid line.

·  Base Line: A value from 0 to (cell height – 1) can be used. Lower case letters with hanging parts like
“g” can utilize the area under the base line.

·  Wid Line: A value from 0 to (cell width – 1) can be used. Characters must fill the area between the
left borderline and the wid line. A good value for wid line is cell width – 2, which allow you to utilize
most of the cell area. Also this value can be used to manually determine the character width for some
characters like “ “ (space), “*”, etc.

·  Load Sys Font: This button is used to load and convert a system font. After you select system font
name, style and size. Click “OK” and the selected font will be converted to a binary matrix format and
displayed on the character list. Not all system fonts name, style or size can be converted successfully
because the limitation in the cell size.

·  Modify CHR: This button is used to save the edited character. After the font is displayed on the
character list. You can edit any character by clicking on the character. The color of the character will
change from black to red and it will be shown on the single character matrix. Now, you can use the
editing tools to edit the selected character. After you are done, click on “Modify CHR” to save it, the
color of the character will change from red to green indicating that this character has been edited and
saved.

·  Send Font To Module: This button is used to send the selected font to the module to be saved in the
Font/BM EEPROM

17.2. Save Font:

To save a font to a file, click on the “Save” icon. Enter a file name and click “Ok”. The font is saved as
binary file (.dat) and only can be read by the font editor. To easily reconagize a font file, add the font name,
system font name, size and style to the file name. For example: Font1_Arial_Reg_8.

17.3. Open Font:

To open a font file, click on the “Open” icon. Select a file name and click on “OK”.
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18. Bitmap Editor:

To edit a bitmap:
·  Select the bitmap size
·  Edit your bitmap using the editing tools
·  To see how the bitmap looks like on the target display, click on “Send To Module” icon
·  If you are satisfied, save the bitmap to a file first. Click on “Save” icon
·  Enter the bitmap name and find an available ID number for this size, then click on “OK”
·  Enter the available bitmap ID number.
·  To save the bitmap in the module EEPROM, click on “Save To EEPROM” icon
·  To check if the bitmap is saved correctly or to find available ID number, click on “Show From

EEPROM” icon.

When you save a bitmap to file, add the bitmap size and ID to the name of the file. This will allow you to
find available ID number for your bitmap. You can also use “Show From EEPROM” icon to scan all the
bitmaps which are saved in the module EEPROM from the selected size. This also will prevent you from
overwrite an already saved bitmap.

Editing
Tools

Enter Bitmap ID
Number

Bitmap
Size

Send, Save and
Show

Save and
Open a
bitmap
file

Edit a
bitmap

Font frame
is disabled
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Not all bitmaps location (ID numbers) are available. Some ID numbers are already used by the objects as
OEM bitmaps. While these bitmaps are editable by the user (not recommended), they must saved with
same ID number as shown by the following table:

OEM bitmap name Size ID number
Blank_8X8_31 8 X 8 31
LBUP_8X8_30 8 X 8 30
LBDown_8X8_29 8 X 8 29
CBchecked_8X8_27 8 X 8 27
Cbunchecked_8X8_26 8 X 8 26
RBchecked_8X8_25 8 X 8 25
RBunchecked_8X8_24 8 X 8 24
LBUPH_8X8_23 8 X 8 23
LBDownH_8X8_22 8 X 8 22
Blank_64X64_31 64 X 64 31
Blank_48X48_31 48 X 48 31
Blank_32X32_31 32 X 32 31
Blank_24X24_31 24 X 24 31
Blank_16X16_31 16 X 16 31
Blank_16X8_31 16 X 8 31
Blank_8X16_31 8 X 16 31
Blank_32X16_31 32 X 16 31
Blank_16X32_31 16 X 32 31

The bitmaps are saved as binary file (.dat) and only can be open by the bitmap editor.

Small Digits (DigitS), Medium Digits (DigitM) and Big Digits (DigitB) bitmaps must be saved
in files using the following format:
DigitS_ID.dat
DigitM_ID.dat
DigitB_ID.dat

Where ID is the bitmap (digit) ID number.
e.g.: To save small digit 0
DigitS_0.dat
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19. Image Loader:

Image is a full screen bitmap and usually used as splash screen to display the company logo or to visually
describe a process. The resolution of the image should be the same as the target display resolution, but it
can be smaller or bigger. In this case, the image loader will embed blank bytes if it is smaller or delete
bytes from the image if it is bigger.
The Image Box has the same dimensions and resolution as the target display so the image shown on the
image box will look exactly as on the target display.
The image loader is also allows you to display and convert a bitmap as long as it has a supported size and
saved as window bitmap (.bmp).

To save an image to the module:
·  Edit your image using any Paint program like “Window Paint Shop Pro” and save it as bitmap (.bmp)
·  From the Image Loader, click on “Load Image”, then select your image and click on “Ok”.
·  Your image now is shown on the Image preview box. Select a positive or negative picture and click on

“Convert” and the image will be shown on the image box.
·  Click on “Send To Module” icon to display the image on the target display.
·  If you are satisfied, give the image an ID number and click on “Save To EEPROM” icon to save the

image in the module Font/BM EEPROM.
·  You can display an already saved image on the target display by clicking on “Show From EEPROM”

icon. Also you can scan the images already saved in the module to find an available ID number for
your new image. This will prevent you from overwrite a saved image.

The same steps are used for a bitmap except be sure that the bitmap has a supported size.

Image Box

Image
preview

Select an
image (.bmp)

Select
Positive or
Negative
image

Convert the image to
B&W and display it on
the image box

Select
Image or
Bitmap

Enter Image ID

Enter Bitmap ID

Send, save and
show

Actual image or bitmap
size
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20. Main Window:

Screen layout is handle in this window.

The main window has four panels:
·   Display
·  Objects browser
·  Objects menu
·  Main menu
·  Layout tools

20.1. Objects browser:
The object browser contain all the screens and objects in the project. By clicking on a Screen, the selected
screen will be displayed on the display and on the target display if the check box “Display Screen” is
selected which provide a real time interface between GooyLCD and the target display. Clicking on an
object contained in the selected screen will highlight the object (the color of the object turns into Yellow)
and you can use the layout tools to edit the object, which include: Move, Delete, Edit Properties and
Simulate.

20.2. Object menu:
The object menu contains all the pre-coded objects, which are used to build the graphical user interface
application. The menu include the following objects:

Objects
menu

Main menu Layout tools

Objects
browser

Display 1:1 compatible to the target display
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21. Adding object to a screen:
For more information about the object, see the module manual.

21.1. Adding GUI object:
GUI objects are windows™ style objects used for implementing advanced windows™ compatible dialogs.
The GUI objects are Label, TextField, CheckBox, RadioButton, ListBox, Form, Button, and TextBox. GUI
objects have one Property window where some of the commands are enabled or disabled depends on the
selected object.

                                                     
                                                                                                                                                       

Object Text
or caption

Number Of Characters

Object width and height

Font preview window

Object name

Object ID assigned
automatically

Select Font

ListBox editting
tools

Border
select

Object
Code

Maximum
number of
objects



16

To add a GUI object to a screen:
·  From the Object menus, click on the object button you need to add
·  The objects property window will appear with the selected object class name shown on the window

header
·  Enter the object name. The object name must be unique for each object and if the object name you

entered match any object name from the same class name, an error occurred. The object ID is
automatically assigned by the software (is not user editable). The Max label shows the maximum
number of objects you can add to one screen.

·  Select Font and Border style if applicable
·  If you need the object to be visible when the screen loaded on the target display then select “Visible”
·  If you need the object to be Touch sensitive ( has a touch zone) then select “Touch”
·  Enter the caption or the object text. If the “AutoSize” is selected, object the software according to the

selected font automatically calculates dimensions (width and height) and caption number of characters
(NOC). If the selected object is a Label or TextBox, the caption or the text will be the object initial text
when the screen is loaded and because the text is editable at run time, the object width must be big
enough to hold (without clipping) the text at run time. If the “AutoSize” is not selected, you can edit
the object width and height. Text is always left justified except the button text, which is center,
justified.

·  If the selected object is ListBox, enter the listbox number of items and the item maximum length in
characters (8 pixels). The item maximum length determines the width of the highlight box when the
item is selected and should be higher than the longest item. Enter the item text and then click on “Add
Item” and repeat that for all items. To remove or edit an item, select the item index and then click on “
Remove Item” or edit the item text.
Example: Let us assume you need to add a 3 items listbox
Item 1: Settings
Item 2: Run
Item 3: Stop
The longest item is item 1 (8 characters) then, Item max length must be higher than 8
Then:
Number Of Items = 3
Item Max Length = 10

·  After you finish editing the object, click on “Apply” and then click on “OK”
·  Move the mouse cursor to the location (within the display area) you need to place the object and left

click
·  To further adjust the object location, highlight the object by clicking on the object name in the object

browser and then use the layout tools to move the object
·  To see how the screen looks like on the target display, click on “Send Screen to module” icon
·  To save the object in the module EEPROM, from “Object” menu, select “Compile and Save”
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21.2. Adding HMI object:
GooyLCD allows you to add the industry leading Human Machine Interface objects to your applications.
The provided HMI objects are: BarGraph, Chart, LinearGage, NumberBox, and Slider. All HMI objects
have one property window where some of the commands are enabled or disabled depends on the selected
object.

To add a HMI object to a screen:
·  From the Object menus, click on the object button you wish to add
·  The objects property window will appear with the selected object class name shown on the window

header
·  Enter the object name. The object name must be unique for each object. If the object name you entered

matches any object name from the same class name, an error occurred. The object ID is automatically
assigned by the software (is not user editable). The Max label shows the maximum number of objects
you can add to one screen.

·  If the object has a bitmap like pointer, handler or digits, click on “Load Bitmap”, the loaded bitmap
will appear on the preview window

·  If you want the object to be visible when the screen loaded, select “Visible”
·  If you want the object to have a touch zone, select “Touch”

Object name

Chart editing
tools

Slider editing
tools Common

commands

LinearGage
editing tools

NumberBox
editing tools

BarGraph editing tools

Object bitmap
preview window

Load object bitmap

The Handler
bitmap must be
8X16

The Pointer
bitmap must be
16X8
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·  Enter the object width and height in pixels. Note that the actual object width and height can be higher
than the entered one. For example, if you enter a 128 for a bargraph height and 8 for its width, the
actual height is 130 and actual width is the same.

·  After you finish editing the object, click on “Apply” and then click on “OK”
·  Move the mouse cursor to the location (within the display area) you need to place the object and left

click
·  To further adjust the object location, highlight the object by clicking on the object name in the object

browser and then use the layout tools to move the object
·  To see how the screen looks like on the target display, click on “Send Screen to module” icon
·  To save the object in the module EEPROM, from “Object” menu, select “Compile and Save”

21.3. Adding Graphics objects:
The graphics objects are Bitmap, ImageSeq and Animation. All graphic objects have the same property
window with some commands are enabled or disabled depends on the selected object.

To add a Graphic object to a screen:
·  From the Object menus, click on the object button you need to add
·  The objects property window will appear with the selected object class name shown on the window

header
·  Enter the object name. The object name must be unique for each object and if the object name you

entered match any object name from the same class name, an error occurred. The object ID is
automatically assigned by the software (is not user editable). The Max label shows the maximum
number of objects you can add to one screen.

·  If you want the object to be visible when the screen loaded, select “Visible”

Object name

Bitmap Size

Loaded bitmap
information

Animation
editing tools

ImageSeq
editing tools

Load a bitmap

Bitmap preview
window
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·  If you want the object to have a touch zone, select “Touch”
·  To select the object bitmap, click on “Load BM”, and then browse to find your bitmap and then click

on ”Load”. The selected bitmap will appear on the preview window
·  If the selected object is ImageSeq, enter the number of images to be sequenced. The starting bitmap ID

will be update when you load the bitmap
·  If the selected object is Animation, enter the number of frames and select the animation movement

style. The starting bitmap ID will be updated when you load the bitmap
·  After you finish editing the object, click on “Apply” and then click on “OK”
·  Move the mouse cursor to the location (within the display area) you need to place the object and left

click
·  To further adjust the object location, highlight the object by clicking on the object name in the object

browser and then use the layout tools to move the object
·  To see how the screen looks like on the target display, click on “Send Screen to module” icon
·  To save the object in the module EEPROM, from “Object” menu, select “Compile and Save”

21.4. Adding Draw objects:
The draw objects are Line, Circle, Ellipse and Rectangle. All drawing objects have the same property
window with some commands being enabled or disabled depending on the selected object.

To add a draw object to a screen:
·  From the Object menus, click on the object button you need to add
·  The objects property window will appear with the selected object class name shown on the window

header
·  Enter the object name. The object name must be unique for each object and if the object name you

entered match any object name from the same class name, an error occurred. The object ID is
automatically assigned by the software (is not user editable). The Max label shows the maximum
number of objects you can add to one screen.

·  If you want the object to be visible when the screen loaded, select “Visible”
·  If you want the object to have a touch zone, select “Touch”
·  Select the draw style and the fill style if applicable
·  After you finish editing the object, click on “Apply” and then click on “OK”
·  Move the mouse cursor to the location (within the display area) you need to place the object, click and

hold the mouse left button
·  Move the mouse (within the display area) with the left button is kept pressed to complete drawing the

object



20

·  If you are done, leave the mouse left button
·  To further adjust the object location, highlight the object by clicking on the object name in the object

browser and then use the layout tools to move the object
·  To see how the screen looks like on the target display, click on “Send Screen to module” icon
·  To save the object in the module EEPROM, from “Object” menu, select “Compile and Save”
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22. Adding a Screen to a project:

A project can have up to 24 screens. By default when the software is loaded, screen0 is automatically added
to the project. The screen name is not editable by the user. To add a screen to a project:
·  From “Project” menu, select “Screen”
·  From Add/Remove Screen, click “Add” to add a screen or highlight a screen and click “Remove” to

remove a screen from a project.

When you remove a screen from a project, all the objects contained in this screen will be removed too. This
action is undoable, so be sure to save the project before removing a screen.
To remove (delete) a screen form the module:
·  From “Project” menu, select “Delete Screen”
·  From Delete Screen window, enter the screen ID you need to delete and click on “Delete Screen”

To load (show) a screen is already saved in the module screen:
·  From “Project” menu, select “Delete Screen”
·  From Load Screen window, enter the screen ID you need to show and click on “Load Screen”

To save a screen to the module
EEPROM. From the Project menu,
click on “Compile and Save a screen”.
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23. Edit Object properties:

To edit an object properties:
·  From the Object browser, click on the object you need to edit. This will highlight the object
·  From the layout tools, click on “Object Property” icon
·  The first 7 properties are not editable. Double click on the property value you need to edit
·  Edit the property value and then press Enter
·  Click on “Apply” to save the change

Visible and Touch properties have a value of 1 or 0 to indicate if the property is selected or not selected.
Font, Border Style, Draw Style and Fill Style properties also have a value (number) assign to them to select
different font or style.

Value Font Border style Fill Style Draw Style Visible Touch
0 - No border Transp. Normal Not Visible Has no touch zone
1 Font1 Normal Solid Bold Visible Has touch zone
2 Font2 Bold Hor. Lines Thick
3 Font3 Thick Ver. Lines Dot
4 Font4 - Cross Dash
5 Font5 - Blank
6 Font6 -

Screen number

The first 7
properties are not
editable

If there is no
value assigned to
the property.
This property is
not applicable to
the selected
object
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24. Simulate:

The simulation window provides a very powerful tool to examine the objects run time properties, check if
the bitmaps, object bitmaps and fonts are saved in the module EEPROM correctly and help you in
designing a user friendly navigation. It also used to simulate your animation using timer trigger events and
to plot different functions on the chart object. For the simulation window to work properly, your screen
must be compiled and saved in the module EEPROM.
To simulate an object:
·  From “Project” menu, select “Compile and Save”
·  From the “Object Browser”, click on the object need to simulate
·  From the Layout Tools, click on the “Simulate” icon
·  The simulation screen will appear with only the selected object run time properties enabled
·  Select, Edit or Click the run time properties and then click on “Send”

RED =   0  (Inactive)
Green = 1 (Active)

Green = Plotting the chart
still in progress
Red = Plotting the chart is
done

Do not close the window
until plotting is done

To automatically trigger the
animation, select Auto and
click on “Play”. To stop,
click on “Stop”

Before you close the
simulation window, be sure
that you stop the animation

If the highlighted object is Label or Text
box, send the label caption or the textbox
text before you highlight/unhighlight or
visible/ invisible the object

List box scroll
up/down

Clear Chart
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25. Programming Mode:

The programming mode is used to program the blank modules providing a powerful tool for mass
production. GooyLCD provide two utilities, one for direct writing to the module EEPROM and the other
for direct reading from the module EEPROM. After you finish from your project and all screens, fonts,
bitmaps and images are already saved in the module EEPROM (we are going to call this module “Master”),
you can use “Read EEPROM” utility to make an exact copy of the master EEPROM and save it to four
individual Hex files. Those files will be the master files to program the blank modules using “Write
EEPROM” utility.

To set the module to the programming mode:
·  Turn off the module and display
·  Disconnect the display connector
·  Set the DIP switch to Programming mode
·  Turn on the module

In this mode, the module will automatically configured to 115.2 kb/sec and to a device ID equal to 16.
The firmware will skip the LCD initialization routi ne so any command needing to access the display
is not allowed.

To configure GooyLCD to the programming mode:
·  From the main menu, select “Config” and then select “Communication”
·  From the “Communication” window, select 115.2 kb/sec baud rate and enter 16 for the device ID

To Read the module EEPROM:

·  From the main menu, select Utilities, then select “Read EEPROM”
·  Select Bitmap EEPROM

The check sum is
the summation of
all bytes

Reading/Writing to the module EEPROM is a sensitive process. Close all other applications including
firewall and virus scanning software.
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·  Click on “Hex File Name”, enter the Hex file name (e.g. Project1_BM EEPROM.Hex) and then click
“Save”

·  Click on “Read EEPROM”
·  When reading the EEPROM complete successfully, the file Project1_BM EEPROM.Hex has an exact

copy of the module Font/Bitmap EEPROM
·  Select Program EEPROM (1) ( Screen0 to 7)
·  Click on “Hex File Name”, enter the Hex file name (e.g. Project1_Prog_1_ EEPROM.Hex) and then

click “Save”
·  Click on “Read EEPROM”
·  When reading the EEPROM complete successfully, the file Project1_Prog_1_ EEPROM.Hex has an

exact copy of the module Program EEPROM (1)
·  Repeat the same steps for Program EEPROM (2) (Screen8 to 15) and Program EEPRM (3) (Screen16

to 23) EEPROM. If your project has only 8 screens or less, there is no need to read EEPROM (2) and
EEPROM (3)

After reading the master module EEPROM successfully. The Hex files which, are saved in the previous
step are the master files which, are going to be used to program the blank modules in the next step.

Programming a blank module require the following two steps:
·  Writing the master files to the module corresponding EEPROM
·  Writing the module configuration bytes (16 bytes) to the module internal EEPROM

The blank module also needs to be set to the programming mode and powered on.

When a project is loaded “Open”, it will overwrite the baud rate and the device ID to the
module configuration values. When you change the baud rate and / or the device ID in the
“Communication” window will also overwrite the values of the baud rate and device ID in
the module configuration window.
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To write the module configuration bytes:
·  From the main menu, select Utilities, then select “Write EEPROM”
·  Select Module Config Bytes
·  Click on “Hex File Name”, enter the  Module configuration hex file name (e.g. Project1_Config .Hex)

and then click “Save”
·  Click on “Write EEPROM”

Repeat the same steps to write (program) to the module Bitmap EEPROM, Program EEPROM (1) ,
Program EEPROM (2) and Program EEPROM (3).

26. Settings:

The settings window allows you to configure GooyLCD IDE upon starting up. The starting up settings
(options) are:
·  Communication and Module
·  Display size and resolution
·  Fonts
·  Object bitmaps

Fonts and object bitmaps (numberbox digits, pointer and handler) can be automatically loaded upon starting
which eliminate the need to down load them every time the software starts.

The starting up settings or options will be written to text file automatically generated by the software, the
file name is “GUILCD.ini”  and it will be saved in the application path.

When a project is loaded, communication, module, display size and resolution will be
overwritten by the project parameters without affecting the selected options in the settings
window
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27. Generate Project Report:

This utility is used to generate a project report. The project report is a text file contains the following
sections:
·  Project header which includes project name, date, and module configuration
·  All the project Screens
·  All objects contained in each screen
·  Object class name, object name, object code and object ID

The report will assist you when you start writing the code for your application.

To generate a project report:
·  From the main menu, select Project and then click on Generate Report
·  From Project Report window, click on File name and enter the report name then click on Save
·  Click on Generate


